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Live Captions Provided

Two Options:

1. Access StreamText link available in the
“Chat” (“Chat” control in Zoom toolbar)

2. Access the “Closed Captions” option
(“Closed Captions” control with “CC”
above it in Zoom toolbar)




Spotlighting and Pinning

Spotlighting

State Agency ADA Coordinators’
Virtual Meet & Greet 2021

Only Host or Co-host can spotlight someone o=

ooooooooooooo

Whoever is spotlighted will appear in Speaker View

Pinning

Any participant can pin any other participant’s video at
any time, and it only impacts that participant’s display
How to Spotlight/Pin Participants

Hover over participant you want to spotlight/pin
Select the ellipses (...)

From the menu, choose “Spotlight for Everyone” or “Pin”



Georgia Tech — CIDI

* Research (disability-related)
* Accessibility Consulting — ICT and UX

Center for Inclusive Design and Innovation
College of Design

 Braille Services

i U8
.. v

e
- = A

e Captioning and Described Audio et TN S T
Services — i A "i"\{{ﬂi‘\!.' &
| ~siH=s3
* Professional E-Text Producers i {?\ e
¢ Ce rtifIEd ASSIStiVE TEChﬂO'Ogy Team We Are Contributing to an Inclusive World

e Tools for Life is celebrating 30
years of service in 2021!



Goals for Today’s Presentation

1. Cover the basics of Microsoft
PowerPoint accessibility using a helpful
Quality Control checklist.

2. Look at specific examples together and
discuss how these could be made
more accessible.




Today’s Presenter

Valerie Morrison, Ph.D., E-Text Manager at CIDI

Valerie Morrison manages the E-Text department at CIDI, making
accessible materials for individuals with print-related disabilities. She
earned her doctorate in English Literature from the University of Georgia
and served as an instructor of composition, contemporary poetry,
American and British literature, and the postmodern novel.

Now, Valerie and her team find innovative ways to transform course
materials quickly and affordably into a wide variety of accessible digital
formats. Valerie and her team work with university staff, publishers,
corporations, and state agencies to ensure the material they create and
distribute will be accessible to those who rely on screen readers, text to
speech software, or other assistive technology to access documents.



Microsoft PowerPoint
Accessibility



PowerPoint Is a Highly Visual Medium

 With so much visual information in the form of graphics, images,
and animations comes an increased need for accessibility

 Things need to be LARGE and CLEAR to reach people in the back of
the room

 Simplicity is key



Checklist for PowerPoint Presentations

Using accessible Layouts so that all text is visible in the outline view.

Writing descriptive slide titles for easy navigation and clarity. ,
Choosing fonts and color contrast for greatest visibility. ‘

Writing brief alternative text descriptions for all images.

Creating white space with page layout tools (not tab, enter, space).
Creating tables with clear navigation and a specified header row.
Using tools on the Home Ribbon for bulleted and numbered lists.

Determining the reading order in the Selection Pane.

L L

Inserting useful metadata.

10. Using the built-in accessibility checker to find and fix errors.



Templates and Layouts

On the Home Ribbon,
click on Layout, and
select a template with
several content
placeholders.

Always use these built-in
layouts. DO NOT insert
text boxes because these
are often skipped by
screen readers.




Outline View

Click on the View tab and Bein Tiansifions | Sniriations

c Bl= = [=[&] | [oz] [T Ruler =
instead of the Normal E=l E= & E] =il 1= R
. . Mormal Qutline Slide MNotes Reading  Slide Handout Notes _ Motes Zoc
Th U m b n a | | VI eW’ Se | eCt View Sorter Page View Master Master Master Guides
R R Presentation Views Master Views Show p
Outline view to see all the 61 Accessible Graphs in Excel
. = When creating graphs of data in Excel from tables, be sure to keep the table near
the grapn. Having a table of data along with a graph will be usetul so people can
. h h ' le of d I ith h wall b ful |

view the data in two different ways to help them process the information.
= Also remember to add a clear header row and alt text to the graph.

¢ Ma ke Su re a ” tEXt On eaCh 62 Alt Text for Other Objects
S I |d e ShOWS u p 3 nd |S not II’] Graphics, smart art, charts, shapes, and tables should have alternative text

descriptions.

an inaccessible text box. 62 | Insert Metadata

By clicking on the File tab and viewing the Document Properties, you can edit
information such as Author, Title, Keywords, or Comments to provide further

¢ De I ete d ny eXt ra h d rd I Ine information about what the document contains. This data will be retained iIf you save
as an accessible PDF,
brea kS that cou Id be read 64  Accessibility Checker in Excel
ll ° ” Al L = ..i_ = + - F . - .D
3 |O u d as b I an k | ine. Use the Accessibility Checker in Microsoft Excel, just as you would in Microsoft

Word. Go to File, then click on Check Issues, and then Check Accessibility to run a
quick report listing 1ssues you need to fix.




Clear Desigh and Format e

* Fonts - use a readable font in a large enough size that your presentation
will be seen throughout the room.

* Colors and contrast - text color should provide enough contrast with
background color that people can easily read it. Readers with low vision
read yellow font on a black background most easily.

e Backgrounds - Always place text on a plain or solid background.

* Inserting a background image allows you to include logos or graphics that
are not read aloud by screen reading software. See logo above.

* Design — be thoughtful with your reading order and your design elements.
Try to keep things as streamlined as possible as best practice.



Avoid Using PowerPoint’s Design Suggestions

10 VALUAELE PROGRAM
1 THE STEPS TO EVALUATION

A community assessment helps you determine the health information needs of
12[] COMMUNITY ASS$SMENT the community, the community resources that would support your project, and
information to guide you in your choice and design of outreach strategies.

13 LOGIC MODEL

1. Get Organized
Step 1: 2. Gather Information s
15 THE LOGIC MODEL: Do a 3. Assemble, Interpret, and Act on your findings
KNOWLEDGE, ATTITUDES, AND BEHAVIORS Community

Assessment

14 TEARLESS LOGIC MODEL

Ultimately:
16 INDICATORS ARE OBSERVAELE SIGNS OF YOUR Learn about the community, key stakeholders, and their needs.

OUTCOMES

17 HOW DO YOU DEVELOP APPROPRIATE
INDICATORS?

12  DEMOGRAPHIC DATA
19 AN EVALUATION PLAN DESCRIEES HOW THE

PROJECT WILL BE EVALUATED
20 ' DEFINE EVALUATION QUESTIONS

 For now, most of the automated Design choices PowerPoint offers are inaccessible
to assistive technology.

* In this example, all of the valuable text content no longer appears in Outline View,
and so it will not be read aloud by the screenreader.



Descriptive Slide Titles

3 CIDI's Products and Services

* Each slide should have a . E-Text Services
. - - o « Braille Services
unlque deSCr|pt|Ve tltle to = Captioning and Audio Description Services
: « Certified Assistive Technology Tools for Life Team
help someone naVIgate = ICT Accessibility Consultations and Website Evaluations
th I‘Ough the presentatiOn. 4 Goals for Today's Presentation
1. Discuss the top three considerations for document accessibility:
* Slide titles help everyone " dlear navigation
= alt text for images
understand and focus on + simple design
. 2. Provide an overview of PowerPoint accessibility
your key pOIntS and knOW 5 Document Accessibility Tips
where you are In your & Who Needs Accessible Documents?
. Digital Accessibility means that your documents and websites are accessible to individuals
presentat|0n . using assistive technology.

» Individuals who are blind, or expenence color blindness or low vision

» Indinviduals with learning disabilities such as dyslexia, dyscalculia, dysgraphia, or ADHD
» Individuals with head injuries, trauma, or cognitive disabilities

= Auditory learners

= Aging population

= Everyone



Color Contrast

Color contrast should
reduce eye strain

Use the free Colour
Contrast Analyser from
the The Paciello Group
(www.paciellogroup.org).

Do not rely on color
coding alone to convey
meaning.

& Colour Contrast Analyser (CCA) Edit
A A

Contrast ratio 1.6:1

Foreground colour

#F1B548

Colour blindness simulation

a
L

| Background colour Monochromacy
Achromatopsia (1.7:1) Achromatomaly (1.7:1)
#DA7C46 no color almost no color

Dichromacy

v Sample preview Protanopia (1.7:1) Deuteranopia (1.7:1) Tritanopia (1.6:1)

no red no green no blue

Trichromacy

Protanomaly Deuteranomaly Tritanomaly
WCAG 2.1 results (1.7:1) 1.7:1) (1.6:1)

1 d I low bl
» 1.4.3 Contrast (Minimum) (AA) o Rl S

Q Fail for large and regular text

¥ 1.4.6 Contrast (Enhanced) (AAA)

Text (including images of text) has a

contrast ratio of at least 7:1 for "regular" sized text
and at least 4.5:1 for large scale text (at least [18pt |/
24px |, or bold and at least |14pt|/[18.5px ), unless
the text is purely decorative.

Q Fail for large and regular text

P

» 1.4.11 Non-text Contrast (AA)

Q Fail for Ul components and graphical objects



https://github.com/ThePacielloGroup/CCA-Win/releases/

How to Describe Images

* First summarize what you
see in one general
informative sentence.

 Keep your description
neutral and informative.

* Use proper grammar,
spelling and punctuation.

* Avoid acronyms and
symbols.

' 1'lL BURN
THIS L:'IT‘I'

FALSERNEES (oM@2018



General Tips for Writing Alternative Text

 Work from general to specific to provide a framework for the
listener, keeping in mind that long descriptions may be cut off.

e Always use proper grammar, spelling, and punctuation, and do
not include any hard line breaks in your image description.

* Provide information in multiple modalities if possible, such as
adding captions for figures and tables.

* Try to reduce redundancy when possible. If the surrounding
text describes the image, your description can be more brief.

* Always edit your alt text thoroughly, enlisting another person
to check your work if possible.



Background Images

 Tryto avoid

e TR A O Lbrany
background he, Y of Medicine
patterns. . e

‘ MLA 2021

c A pla In j / -10:15 am — 11:15 am (CT)
background :
reduces eye
strain and helps
someone focus
on the text.

~nT " “Continue the Conversation!
~11:15 am - 12:15 pm (CT)




Animated text or graphics
may provide visual
confusion or be
completely unavailable to
some users

Best practice would be to
take a screenshot of the
animation and describe it
with alternative text

Also consider providing a
caption to describe the
animation




Embedded Videos

* Embedded videos should
have accessible captions
and/or audio description
to be truly accessible

* Consider providing a still
image from the video and
describing it with alt text

* Also, remember that many
times someone will print
or save a presentation as a -

PDF, and the video will not all i i
be available

GODZILLA




Accessible Spacing

Paragraph

General

Alignment: | Left

Indentation

Before text: 0.5

Spacing

Before: 6,72 pt
After: & pt
Tabs...

L ILANIE] L

Special:

Line Spacing:

Hanging s~

Single

S

By:

0.5°

QK

4|k

Cancel

Create accessible
white space with
the Paragraph
group on the
Home Ribbon.

You can add space
before or after a
line, or create
indents here
without hitting
enter or tab
repeatedly.



Contextual Hyperlinks

Follow the steps below to create the most accessible links in your PowerPoint:

1. Write the name of link in plain language. If possible, provide a brief description of
what the person will find by going to that particular website.

2. Highlight the plain language name of the link and right click to Insert a Hyperlink.

3. Paste the URL in so that the title turns into a clickable link.

4. Add the URL in parentheses after your hyperlink, and right click to remove the

hyperlink from the URL. This last step is for those who may print your PowerPoint.

Example: To learn more about our educational programs, workshops, classes, and
events, please visit The Department of Natural Resources Education website
(www.gadnr.org/education).



http://www.gadnr.org/education

Accessible Table Design

H ©-2 g = Creating Accessible PowerPoint Presentations.pptx - PowerPoint Table Tools

File Home Insert Design Transitions Animations Slide Show Record Review View Help Acrobat Table Design

HEEdEF HDW |:| First I:IIIlLII"I"II"I E E‘ E‘ _____ E‘ __________ - ﬁghﬂdlﬂg b A*J ﬁ b
[ ] Total Row [ | Last Column === f:.:.:.:.:. f:.:.:.:.:. ——— == f:.:.:.:.:. ——— I ————|ll~ H Borders ~ [l"l;k i w
__________ | B/—— F/———— /—— /———— ————lI— Uit "
[ | Banded Rows [ | Banded Columns - e T | L& Effects ~ Styles fay -~
Table Style Options Table Styles Wordart Styles T

 To add a table, go to the Insert tab to select the number of rows and
columns you need. Or, you can simply paste in a table from MS Word.

 Tables need a clear header row, and should not be used for layout or
design purposes only.

e C(Click on the table itself to access the Table Design tab to specify a
header row, adjust colors, or add in helpful borders between each cell.



Table Navigation

* Avoid merging cells or having any empty cells to make navigating
table cells easier for those using assistive technology.

 This sample table below has a clear Header row, borders between
cells, high color contrast, and no merged cells for easy navigation.

Name Course Title Requirements Major
Menke ENGL 4897 Science Fiction ENGL 1102 Not required
ENGL 3000
Rosenbaum ENGL 4770 Introduction to ENGL 1102 Not required
American Poetry ENGL 3000




Adding Structural Alt Text for Tables
Physical Properties

of the Giant Planets

Consider adding structural alt text
and/or captions to tables. This allows

someone to hear what the table Jupier | Satum | uranus [Neptuns
. . . l:l;h'ltal semimajor axis 5.20 9.6 19.2 30
contains before listening to all the o
Orbital period (Earth 1.9 295 4.0 164.8
data. s :
Orbital velocity (km/s) 13.1 07 6.8 5.4
Mass (M__, =1) 3178 95 14.5 17.1

Equatorial radius (km) 71 490 60,270 25560 24 300

Table 10.1 is titled Physical Properties of the

Equatorial radius 11.2 95 4.0 3.8
Giant Planets. It has 5 columns and 13 rows. :;;;:;:ss P rwwee—
The column headings are Physical Property, Tr——— oo 12 e
Jupiter, Saturn, Uranus, and Neptune. Rotation period (howrs) 6.9 107 172 160

Tilt (degrees) 3.13 26.7 097.8 28.3

Surface gravity 253 1.07 0.59 1.14

(relative to Earth’'s)
Escape speed (km/s) 595 35.5 21.3 23.5




Selecting Reading Order

 Onthe Home ribbon, select Arrange > selection and Visibility v X
Selection Pane. Shapes on this Slide:

* In the Selection and Visibility pane, all the Ficture 16 =
elements on the slide are listed in reverse Bicture 13 E
order. The tab order of objects begins at _
the bottom of the list and tabs upwards. Content Placeholder 8 k-

* Elements can be re-ordered using the Text Placeholder 5 =
arrgvy§ at the bottom of the Selection and Title 1 E
Visibility pane.

* The fewer objects on a slide, the more
accessible for someone using a screen
reader to listen to content aloud.



Reduce the Number of Objects on a Slide

Selection
Show All Hide all

Title 1

Modernization RoadMap

Straight Connector 91

Straight Connector 90
Rectangle 89

| 2019 2020 2021

= g Oval 83
() Request for ) Public meeting () Public webinar %,/ Public meeting g e Owal 36
information (RF1) . i X
for external input i Public webinar TextBox 23
O Consultation with MIH TextBox 82
internal stakeholders . —
Arrow: Curved Down 77
~ 2T " T4 s A
a Q0 e E Arrow: Curved Down 76

Meetings with NLWM's éoam of Regents Public Service Working GFuup on ClinicalTrials_gov Modemization Zi%
Arrow: Curved Down 75

(’ \ New test version of website Arrow: Curved Down 74
a to launch Fall 2021. ¥ i
oo < Group 70
T H;rm1] I d for firmdis e :tand.l' shari o : ing clinical frial informati Rectangle &2
B P Lt e R Picture 7
lata mesearchers
t“‘ : - K 4 Group 66
£ Modearnization e Fante] Protocol Registration and Results System (PRS) R e 69
effort launched Hl_r | 1? ik i i \ectangle 69
by NLM utomation approaches : e
Data Providers Picture 68
Improved features for submitting and managing clinical frial information Rectangle 65
= E s o Agile teams and Rectangle 64
A 2 E processes established Arrow: Right 63
1113 T @ O woveu Enhance Cloud-based Infrastructure and Development Processes Ariow Riaht-62
c& platform to it i
= MNCEI Updated plaiform fo improve refiability, sustainability, and support growth Rectangle 61
infrastructure Cval 60
TextBox 59
Oval 58
TextBox 56
L . bl - cc
m) National Library of Medicine Cfmi‘[’{]‘frr.'{.'l's.gm‘ + Arrow: Right 35
= Rectangle 29

Rectangle 1031

9999999999999 9999 JJ3) )39

Individuals using
assistive technology
will need to tab
through every object
on the slide to hear it
read aloud

Consider creating a
snippet of all these
objects so there’s just
one image on the slide
that’s easy to describe



Fix Overlapping Content

* When objects overlap on a slide, Example of Overlapping Objects:
it may cause the screenreader to B——— R — —
. . : LI Y Frd dL YOUT -
read aloud the dimensions of the ,[T - ¥ ey
e room.

objects. .
plain or solid background.

* To avoid this, select all objects /0u to include graphics

on a slide by hitting CTRL + A, ling software. For | |
and resize placeholders or ply a background image.
images so that they are not 1 provide enough contrast

overlapping. n easily read it. Readers

. dolack background most
e Also, be sure to resize your

placeholders so they completely

: te with text placeholders.
contain the text.

ar and make sure that all



Add Descriptive Metadata

Properties ~

* |f you are making your document :I: , E';:'E'ME

available online, metadata helps H:d:;m“deg 3

people flnd your information. Title Accessible Documents and P...
* By clicking on the File Tab and Tags Addatag

clicking Info, you can an Author, Categanes Add a category

Title, Subject Tags, or Comments Related Dates

to provide further information eo[redtes e g oo

about what the document Created 3,3.:.;.:.1;,1:1.:.F.M

contains. Last Printed

e This data will be retained if you
save as an accessible PDF.

Related People

Author ) ]
Valerie Morrison

Add an author



Using the Accessibility Check

Accessibility M
* To run the Accessibility Checker, go to
the Review tab and select Check

Inspection Results

Errors
ACCESSIbIIIty' > Missing alternative text (1)
* |If you have an older version of Warnings

Microsoft Office, go to the File tab and v Check reading order
click Check for Issues, and from the Slide 32

Slide 42
drop-down menu, select Check
Accessibility.

* This will run a report allowing you to
find and fix inaccessible content. +| Keep accessibility checker running

while | work



Working Through the Checklist Together

Going beyond the Accessibility Check and using our own checklist, what are some
adjustments we could apply to this slide to make it more accessible for a screenreader?

7 PROJECT OVERVIEW: STEPS -
9  EVALUATION BACKGROUND https://nnlm.gov/neo/guides/pathways ‘ﬁl
10 WHAT IS EVALUATION? v - -
11 EVALUATION STATION i i e | e
. - s-tep 2 Dewelop In |.!'|'l\.u'!l\.-|:- Evallwation Fiam
12 EVERYONE BUILDS THEIR “STATION e
DIFFERENTLY B e

Adiraiment

121 WHAT HAPPENS AT THE STATION?

14  WHY SHOULD WE EVALUATE?
Are you writing a proposal or working on a project?
Incorporating an evaluation info project design and
implementation is essential for understanding how
well the project achieves ifs goals.

Why evaluate?

» Data gathered through evaluation ensures that we
are creating the best possible programs

= Leamn from mistakes -

Rural Health Pathway



Georgia ﬁ Center for Inclusive
Tech -:Lj‘l:lesign and Innovation

Questions and Answers



Georgla Center for Inclusive
Design and Innovation

Contact Us

T

Contact our Customer Support Team
by phone (404) 894-7756 or by email
cidi-support@design.gatech.edu
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